
ProSync™ User’s Guide
Version 1.01

© Copyright 1994 by TEC Computer Consultants
All Rights Reserved.

TEC Computer Consultants
161 Sixth Avenue

New York, NY 10013
Tel: 212-229-9400
Fax: 212-229-9491
AppleLink: TEC

CompuServe: 76166, 1630

ProSync History
ProSync was developed in response to the needs of the folks who created it, us that is. We are a 
computer consulting firm in New York City, and our consultants frequently work with 
PowerBooks at off-site locations. We use a FileMaker Pro™ database to manage our clients, 
contacts, and leads information, and distribute copies of our database to our consultants.

What happens when a new record is added to the copy of our database in the main office? How 
about when one of our consultants in the field updates a fax number in their copy of the 
database?  What about when records are added in an off-site copy of the database and deleted in
the main office, and visa-versa? Our databases are then “out-of-sync.” How do we get our 
FileMaker Pro databases back in-sync? 

First we tried manually to do a weekly record by record comparison to see what had changed 
between our “master” and “remote” databases. We tried this method only once. Then, as we are 
FileMaker Pro experts, we put our heads together and tried to devise schemes using various 
calculations and scripts to get FileMaker Pro itself to synchronize our database files for us. No 
luck; FileMaker Pro just isn’t up to the task to figuring out all the possible ways in which 
database files can get out-of-sync.

Desperately needing to synchronize our files, we went out and built our own synchronization 
utility using Apple’s System 7 scripting extension called AppleScript™. When we had finished 
developing our application we realized that 1) there were probably plenty of people with the 
same needs as ourselves, 2) AppleScript was the best way to do it, 3) we could maybe even sell 
our solution!

There you have it, and here is the result, ProSync. 
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CAVEAT EMPTOR
ProSync is slow! Why? Because it is doing a heck of a lot of work, and because AppleScript 
itself is slow. However, we are sure that ProSync is a whole lot faster than reconciling your 
database files manually. We recommend firing off ProSync at the end of a work day with 
FileMaker Pro as the only open application, and when you can be sure ProSync will not be 
interrupted by intruding processes. BE SURE TO MAKE BACKUP COPIES OF YOUR FILES
BEFORE SYNCHRONIZING THEM WITH PROSYNC!

Installing ProSync into existing databases requires a bit of work on the part of the user. We’ve 
made the installation as simple as we know how.

ProSync requires System 7.x, FileMaker Pro 2.1.x, and at least 4 megabytes of RAM.

INSTALLING PROSYNC
Inside the ProSync™ Folder are the following items:

AppleScript™
Apple® Events Manager
Master
ProSync
ProSync Questionables
ProSync Settings
ProSync User’s Guide
Questionables
QuickTime™
Remote
Scripting Additions

Drag AppleScript™ and Apple® Events Manager to your System folder; they will automatically
be installed in your Extensions folder. If you are using System 7.0 or System 7.0.1, you will 
also need to install QuickTime™ by dragging it to your System folder for installation inside 
your Extensions folder.

The Scripting Additions folder must be manually placed in your Extensions folder by opening 
your System folder, and dropping the Scripting Additions folder into the Extensions folder.

You must now restart your computer to begin using ProSync.

• For those with AppleScript™ already installed, if you are using earlier 
versions of Apple’s software, follow the above installation instructions. If 
you are using more recent versions of Apple’s software than provided by 
ProSync,  please be sure to drag into your Scripting Additions folder any 



scripting additions provided by ProSync not found in your Scripting 
Additions folder.

I. SAMPLE FILES

Inside the ProSync Folder are the Master, Remote and Questionables FileMaker Pro databases. 
They are provided for demonstration purposes, and may even be used as templates. To be sure 
that ProSync is properly installed, begin by opening the Master file. This file is already 
synchronized with the Remote FileMaker Pro database, that is, all their records are identical.

In the Master file,  change the information in a few fields here and there, not more however 
than you’ll be able to remember, or make as many changes as you’d like and write them down. 
Click the ProSync™ button to run ProSync. After a few seconds an open dialog box will 
appear asking you to select the file you’d like to synchronize with the Master file; select the 
Remote file. After a few moments ProSync will also ask you to locate the Questionables file.



Give ProSync a few minutes to do its thing. A dialog box will let you know when ProSync has 
finished synchronizing the Master and Remote databases. Now look in the Remote file to find 
the changes you made in the Master. You could alternately have opened the Remote file and 
made changes there, or opened both files and made changes to either.

The Questionables file is where ProSync places records that it can’t synchronize without your 
help. More about the Questionables file later.

II. WHAT NEXT?
There are two directions to go now to put ProSync to work for you. 

• Starting with the Master and Remote Templates, section III.
• Installing ProSync Into An Existing FileMaker Pro database, section IX.

Please note that once files have been distributed for later synchronization with ProSync, no 
changes can be made to either file’s fields or layouts. That is, no layouts or fields can be added, 
modified, or deleted until the files have been re-synchronized and the ProSync installation 
process in repeated as described in section IX. 

III. STARTING WITH THE MASTER AND REMOTE TEMPLATES

Granted, the Master and Remote databases are pretty wimpy contact templates, but they do have
ProSync pre-installed. If you decide to use ProSync by building off of these templates, you will 
need to follow these guidelines.

Please take a moment now to review sections IV. Required Fields, and V. Required Layouts. 
Now that you’re back, all you really have to keep in mind while customizing either the Master 
or Remote databases to fit your needs, is that you can’t delete any of the required fields or 
change any of their calculations, that the “Run ProSync” layout must contain every field in your
database, and that the Duplicate Check layout must contain every field in your database 
except for the required fields and any user specific fields.

When you have finished customizing either the Master or Remote files, you will need to create 
an exact copy of this file. Do so by selecting “Save a copy as...” from the FileMaker Pro File 
menu. Be sure that “copy of current file” is selected in the Save As dialog, and type any name 
you’d like except for “Questionables.” You have now created “master” and “remote” copies of
your database.

Repeat the above steps, except this time name your file “Questionables.” Open the 
Questionables file, and select “ScriptMaker™...” from the scripts menu. Follow the 
instructions in section VII. Adding ProSync Scripts.

When you have finished adding the “ProSync” script to your Questionables file, follow the 



instructions in section VIII. Questionables File.

Now open either your “remote” or “master” file and click the “ProSync” button in the “Run 
ProSync” layout, (or select the ProSync script from the Scripts menu). Though these two files 
are currently identical, ProSync needs to be run to prepare them for future synchronization. 
When ProSync has finished, the files are ready to be distributed.

IV. REQUIRED FIELDS

In order to work with any FileMaker Pro databases, including the Master and Remote files, the 
following fields are required:

Field Name Field Type Formula / Entry Option
Unique Id Number Serial Number with Current Value: "x" Increment: "1"
Creation Date Date Auto-enter the: "Creation Date"
Modification Date Date Auto-enter the: "Modification Date"
Modification Time Time Auto-enter the: "Modification Time"
Date Last Synced Date
Time Last Synced Time
Added Flag Calculation(Number) =if(Creation Date > Date Last Synced, 1, 0)
Modified Flag Calculation(Number) =if(Added Flag = 0, if(Modification Date > Date Last 

Synced or Date Last Synced = Modification Date and 
TextToTime(Hour(Time Last Synced) & ":" & 
Minute(Time Last Synced)) + 120 < 
TextToTime(Hour(Modification Time) & ":" & 
Minute(Modification Time)),1,0),0)

Unique Key Calculation(Text) =First Name & Last Name & Company & Phone (User 
definable - see section V. Unique Key Field)

Optional, but 
recommended: Date
Time Last Synced

Calculation(Text) =DateToText( Date Last Synced) & " • " & 
TimeToText(Time Last Synced)



ProSync expects these fields to be defined exactly as shown above, i.e., with identical names, 
field types, and field calculations and options. ProSync does not care about whether the field 
names or calculations are typed in upper or lower case, or whether the spacing is identical 
between field names, functions and operators in the field’s calculation formula.

Please note that the Unique Key field’s calculation formula is user definable, and must be 
customized according to the design of the database being used with ProSync. Please see section 
V. Unique Key Field for more about the Unique Key field.

The Date Time Last Synced field is not required, but is recommended. It displays the last 
date and time that your files were synchronized.

If any of the required fields are missing from the files to by synchronized, or if their 
calculations are incorrect, ProSync will display a message explaining what the problem is, and 
will not run until the problem is corrected.

V. UNIQUE KEY FIELD

The Unique Key field is a text calculation which concatenates (combines) other fields in your 
database into a single text string. In the example provided by the Master file, the Unique Key
field’s calculation is defined as “=First Name & Last Name & Company & Phone.” The Unique
Key calculation for Bill Gates’ record results in the following: “BillGatesMicrosoft555-0000.” 
ProSync uses the Unique Key field to help identify and delete exact duplicate records.

Let’s imagine that your database is designed so that if you wanted to enter John Sculley’s business and home 
addresses you would need to create a separate record for each address. A Unique Key calculation which 
included an address field would “see” that the records were not identical, even though all other information in 
the records could be identical.

It is certainly possible that your database could contain records for two different people working at the some 
company, with the same address and phone number. In this example you would want to include the person’s 
name field in the Unique Key field’s calculation to differentiate between the two records.



As the purpose of the Unique Key is to uniquely identify a record, you will need to change it’s calculation 
depending upon the design of your database.

VI. REQUIRED LAYOUTS

“Run ProSync” Layout. ProSync must be run from a layout which contains every field in your database. The 
simplest way to create a “Run ProSync” layout is to go into Layout mode (select Layout from the Select menu), 
select New Layout from the Edit menu, and in the New Layout dialog box leave the default layout type set at 
Standard, type the layout name of your choice, and click the OK button. This new layout will contain every 
field in the database. As this is the layout from which ProSync will be run by pressing the “ProSync” button (or 
by selecting ProSync from the Scripts menu), it makes sense to name the layout according to its purpose.

If you’d like to attach your ProSync script to a button, please see Chapter 5-17 of the FileMaker Pro User’s 
Guide for directions.

Duplicate Check Layout. 
Duplicate Check is a required layout, and its required name. This layout must contain every field in your 
database except for ProSync’s required fields. To create the Duplicate Check layout, follow the same steps
used in creating the “Run ProSync” layout, and be sure to delete ProSync’s required fields from the layout. See 
section IV. Required Fields for a review. ProSync will not run without the Duplicate Check layout.

Please note that any fields which are user or machine specific must also be omitted from the Duplicate Check 
layout. Examples of such fields are fields into which the user editing the record would enter their name, or any 
field which automatically enters the user’s name or the creation or modification date.

VII. ADDING PROSYNC SCRIPTS

Select “ScriptMaker™...” from the Scripts menu in FileMaker Pro. In the Define Script dialog 
box enter “ProSync” in the Script Name field and click the “Create” button. In the resulting 
Script Definition dialog box click the “Clear All” button. Scroll down the Available Steps list 
box and select “Send Apple Event [...]” as shown below. Double-click the selection or click the 
“Move” button.



The Script Definition dialog should now appear as shown below. In the right-hand box, double-
click on “Send Apple Event []”, or select “Send Apple Event[]” and click the “Specify” button.



In the resulting Specify Apple Event dialog box, select “Send the open application event with” 
from the pop-up list. If you are creating a script for the Questionables file, select the  
application program “ProSync Questionables” in the open file dialog, otherwise select the 
application program “ProSync.” Check the “Bring target application to foreground” box and un-
check the “Wait for event completion before continuing” box.



The Specify Apple Event dialog should now appear as follows, (substitute “ProSync” for 
“ProSync Questionables” if you are adding scripts to your working database file):



Click the “OK” button. The Script Definition dialog should appear as follows, (substitute 
“ProSync” for “ProSync Questionables” for adding scripts to your working database file):



Click the “OK” button, and then “Done.” You have finished adding the required script to your 
file.

VIII. QUESTIONABLES FILE

Please note that the “Run ProSync” layout is the only required layout in the Questionables 
file and that all other layouts must be deleted from the Questionables file. 

The Questionables file has three required text fields which must be added to your Questionables file’s 
“Run ProSync” layout. They are “Source File”, “Explanation”, and “When Modified.” These fields provide 
useful information regarding “un-resolvable” records. ProSync will not run without these fields.

To add the “Source File”, “Explanation”, and “When Modified” fields, select “Define Fields...” from the Select 
menu. In the resulting Define Fields dialog box add these three fields as text fields, with their names spelled 
exactly as shown above. Next, enter layout mode and add these three fields to the “Run ProSync” layout.

We recommend adding two buttons to the “Run ProSync” layout, after deleting any other buttons which may 
appear on the layout, one for deleting the current record, and the other to run the ProSync script you’ve just 
created. See section Chapter 5-17 of the FileMaker Pro User’s Guide for instructions on how to attach scripts to 
buttons.

The Questionables file is used to temporarily store records which ProSync is unable to synchronize or 
“resolve” without your help. Please note that all records which are added to the Questionables file have been 
deleted from their originating file.



Records are added to the Questionables file if:



• Previously synchronized records are modified in both the “master” and “remote” copies of your 
database.

• A previously synchronized record remains in one file and was deleted from the other.
• A previously synchronized record was deleted from and re-added to a file and is not identical to the 

previously synchronized record in the other file (rare but what the hey).

When ProSync is finished running, if it has encountered any “un-resolvable” records during synchronization, it 
will present you with a dialog asking that you please check the Questionables file for these records.

We highly recommend that you immediately check Questionables and either add each “un-resolved” record 
to both copies of your file by pressing the “ProSync” button (or selecting ProSync from the Scripts menu), or 
permanently delete it. The Questionables file will have no remaining records when you are finished.

IX. ADDING PROSYNC TO AN EXISTING FILEMAKER PRO DATABASE

Open the file you’d like to distribute copies of for remote use. First add the required fields as specified in 
section IV. Required Fields. When creating the Added Flag and Modified Flag calculation 
fields, instead of manually typing in the calculation formulas, we’d like to suggest that you copy the formulas 
from the Required Fields table in section IV. and paste them directly into the formula box in the Options for 
field dialog box in FileMaker Pro. Be sure not to include the equal sign “=“ when you copy the formulas from 
this guide.

The Unique Key field’s calculation requires that you now divert your attention to section V. 
Unique Key Field.

When you have finished adding all the required fields to your database and defining the Unique Key field’s 
calculation formula, follow the directions in section VI. Required Layouts for creating the “Run 
ProSync” and Duplicate Check layouts.

When your “Run ProSync” and Duplicate Check layouts have been created, follow the directions in 
section VII. Adding ProSync Scripts, substituting “ProSync” for “ProSync Questionables” as the Apple 
Event target application. We like buttons, and if you do too, please see section Chapter 5-17 of the FileMaker 
Pro User’s Guide for instructions on adding buttons to your file.

Next, select “Find All” from the “Select” menu. Click in the “Unique Id” field to make it the currently selected 
field. Then select the “Replace...” command from the “Edit” menu. In the resulting dialog box select “Replace 
with serial numbers,” enter “1” in the Initial Value field, be sure that the “Update serial numbers in Entry 
Options?” check box is checked, and click the “Replace” button.



The Replace dialog should appear as shown above.

Now you are ready to create an exact copy of your database file. Select “Save a copy as...” from FileMaker 
Pro’s File menu. Be sure that “copy of current file” is selected in the Save As dialog, and type any name you’d 
like except for “Questionables.” You have now created “master” and “remote” copies of your database.

Repeat the above steps, except this time “Save a copy as...” a “clone (no records)” and name your file 
“Questionables.” You will now need to follow the directions in section VII. Adding ProSync Scripts to add 
ProSync to your Questionables file.

Now open either your “remote” or “master” file and click the “ProSync” button in the “Run ProSync” layout, 
(or select the ProSync script from the Scripts menu). Though these two files are currently identical, ProSync 
needs to be run to prepare them for future synchronization. When ProSync has finished, the files are ready to be 
distributed.

X. HELPFUL FILEMAKER PRO USER’S GUIDE CHAPTERS

• Chapter 5-17 Using Buttons with Scripts
• Chapter 5-27 Using Apple Events

TRADEMARKS

ProSync is a trademark of TEC Computer Consultants. Apple, Mac, Macintosh, AppleScript, 
Finder, System 7 are all registered trademarks of Apple Computer, Inc. Claris, FileMaker Pro, 
ScriptMaker are all registered trademarks of Claris Corporation.

SOFTWARE LICENSE
PLEASE READ THIS LICENSE CAREFULLY BEFORE USING THE SOFTWARE. BY USING THE SOFTWARE, YOU 
ARE AGREEING TO BE BOUND BY THE TERMS OF THIS LICENSE. IF YOU DO NOT AGREE TO THE TERMS OF 
THIS LICENSE, PROMPTLY RETURN THE UNUSED 



SOFTWARE TO TEC COMPUTER CONSULTANTS (TEC) AND YOUR MONEY WILL BE REFUNDED.

1. License. The application, demonstration, system and other software accompanying this License, whether on disk, in read only 
memory, or on any other media (the “Software”), and the related documentation and fonts, are licensed to you by TEC. You own the 
disk on which the Software and fonts are recorded but TEC retains title to the Software, related documentation and fonts. This License
allows you to use the Software and fonts on a single computer, to make one copy of the entire Software and fonts in machine-readable 
form for backup purposes only. You may also transfer all your license rights in the Software and fonts, the backup copy of the 
Software and fonts, the related documentation and a copy of this License to another party, provided the other party agrees to accept the
terms and conditions of this License.

2. Restrictions. The Software contains copyrighted material, trade secrets and other proprietary material. In order to protect them, and
except as permitted by applicable law, you may not decompile, reverse engineer, disassemble or otherwise reduce the Software to 
human-perceivable form. You may not modify, network, rent, lease, loan, distribute or create derivative works based upon the 
Software in part or in whole. You may not electronically transmit the Software from one computer to another or over a network.

3. Termination. This License is effective until terminated. You may terminate this License at any time by destroying the Software, 
related documentation and fonts and copies thereof. This License will terminate immediately without notice from TEC if you fail to 
comply with any provisions of this License. Upon termination you must destroy the Software, related documentation and fonts and 
copies thereof.

4. Export Law Assurances. You agree and certify that neither the Software nor any other technical data received from TEC, nor the 
direct product thereof, will be exported outside the United States except as authorized and as permitted by the laws and regulations of 
the United States. If the Software has been rightfully obtained by you outside of the United States, you agree that you will not re-
export the Software nor any other technical received from TEC, nor the direct product thereof, except as permitted by the laws and 
regulations of the jurisdiction in which you obtained the Software.

5. Government End Users. If you are acquiring the Software and fonts on behalf of any unit or agency of the United States 
Government, the following provisions apply. The Government agrees:

1. if the Software and fonts are supplied to the Department of Defense (DoD), the Software and fonts are classified as 
“Commercial Computer Software” and the Government is acquiring only “restricted rights” in the Software, its documentation and 
fonts as that term is defined in Clause 252.227-7013(c)(1)  of the DFARS; and

2. if the Software and fonts are supplied to any agency of the Unites States Government other than the DoD, the 
Government’s rights in the Software, its documentation and fonts will be as defined in Clause 52.227-19(c)(2) of the FAR or, in the 
case of NASA, in Clause 18-52.227-86(d) of the NASA Supplement to the FAR.

6. Limited Warranty on Media. TEC warrants the diskette on which the Software and fonts are recorded to be free from defects in 
materials and workmanship under normal use for a period of ninety (90) days from the date of purchase as evidenced by a copy of the 
receipt. TEC’s entire liability and your exclusive remedy will be the replacement of the diskette not meeting TEC’s limited warranty 
and which is returned to TEC with a copy of the receipt. TEC will have no responsibility to replace a diskette damaged by accident, 
abuse or misapplication. ANY IMPLIED WARRANTIES ON THE DISKETTE, INCLUDING THE IMPLIED WARRANTY OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, ARE LIMITED IN DURATION TO NINETY (90) DAYS
FROM THE DATE OF DELIVERY. THIS WARRANT GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY HAVE OTHER 
RIGHTS WHICH VARY BY JURISDICTION.

7. Disclaimer of Warranty on Software. You expressly acknowledge and agree that use of the Software and fonts is at your sole risk.
The Software, related documentation and fonts are provided “AS IS” and without warranty of any kind and TEC and TEC’s 
Licensor(s) (for the purposes of provisions 7 and 8, TEC and TEC’s Licensor(s) shall be collectively referred to as “TEC”) 
EXPRESSLY DISCLAIM ALL WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. TEC DOES NOT WARRANT THAT
THE FUNCTIONS CONTAINED IN THE SOFTWARE WILL MEET YOUR REQUIREMENTS, OR THAT THE OPERATION OF 
THE FUNCTIONS CONTAINED IN THE SOFTWARE WILL MEET YOUR REQUIREMENTS, OR THAT THE OPERATION OF 
THE SOFTWARE WILL BE UNINTERRUPTED OR ERROR-FREE, OR THAT DEFECTS IN THE SOFTWARE AND THE 
FONTS WILL BE CORRECTED. FURTHERMORE, TEC DOES NOT WARRANT OR MAKE ANY REPRESENTATIONS 
REGARDING THE USE OR THE RESULTS OF THE USE OF THE SOFTWARE AND FONTS OR RELATED 
DOCUMENTATION OR THEIR CORRECTNESS, ACCURACY, RELIABILITY, OR OTHERWISE.  NO ORAL OR WRITTEN 



INFORMATION OR ADVICE GIVEN BY TEC OR A TEC AUTHORIZED REPRESENTATIVE SHALL CREATE A WARRANTY 
OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY. SHOULD THE SOFTWARE PROVE DEFECTIVE, YOU 
(AND NOT TEC OR A TEC AUTHORIZED REPRESENTATIVE) ASSUME THE ENTIRE COST OF ALL NECESSARY 
SERVICING, REPAIR OR CORRECTION. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED 
WARRANTIES, SO THE ABOVE EXCLUSION MAY NOT APPLY TO YOU.

8. Limitation of Liability. UNDER NO CIRCUMSTANCES INCLUDING NEGLIGENCE, SHALL TEC BE LIABLE FOR ANY 
INCIDENTAL, SPECIAL OR CONSEQUENTIAL DAMAGES THAT RESULT FROM THE USE OR INABILITY TO USE THE 
SOFTWARE OR RELATED DOCUMENTATION, EVEN IF TEC OR A TEC AUTHORIZED REPRESENTATIVE HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. SOME JURISDICTIONS DO NOT ALLOW THE LIMITATION OR 
EXCLUSION OF LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES SO THE ABOVE LIMITATION OR 
EXCLUSION MAY NOT APPLY TO YOU. In no event shall TEC’s total liability exceed to you or any third party for all damages, 
losses, and causes of action (whether in contract, tort (including negligence) or otherwise) exceed the amount paid by you for the 
Software and fonts.

9. Controlling Law and Severability. This License shall be governed by and construed in accordance with the laws of the United 
States and the State of New York, as applied to agreements entered into and to be performed entirely within New York between New 
York residents. If for any reason a court of competent jurisdictions find any provisions of this License, or portions thereof, to be 
unenforceable, that provision of the License shall be enforced to the maximum extent permissible so as to effect the intent of the 
parties, and the remainder of this License shall continue in full force and effect.

10. Complete Agreement. This License constitutes the entire agreement between the parties with respect to the use of the Software, 
related documentation and fonts, and supersedes all prior or contemporaneous understandings or agreements, written or oral, regarding
such subject matter. No amendment to or modification of this License will be binding unless in writing and signed by a duly 
authorized representative of TEC.


